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nShot is a powerful and easy to use video editor
which serves as the best replacement for Adobe
Premiere Pro. With a simple user interface, OpenShot

product or service. This loss is also very visible
with the adobe creative suit. They have no ey
competition, so0 they have no strive to evolve as a

There arxe a lot of alternatives
for the adoke creative suit but due
to an eight-page constraint I am

#%Color list from the Adobe
pﬁotcsheps color picker. After
clicking the drop-~down menu and
selaecting the Pantone Color book

only gning to talk about the d R ) f th i B . dding sli _
"populair” softwares. This list product; most of the t me they are just adding , et | & umb i our swatch are in Pantone Solid.
will also only includé open source of life additions or making certain” ‘tools’ easier provides a large number of features Bo weitkiy: tund the Siret. Sew

digits of the specific Pantone
color you need. @.¢ to find Pantone
232 C; type in “232% and Photoshop
will bring up the color. It's
important you type quickly so that
Photoshop searches the digits as

- one number rather than single
digits. You may also search for the
€O

software because otherwise there
ggulg be a chance for a monopoly
zt. a 7

for the user. These changes are not always bad but
this loss of innovation is making the future of the
adobe creative sulit very bland, black and white.

: One of the more recent examples of the Adobe
monopoly in practice is the new Adobe Pantone payment
system. The software giant said that the standardized

DARKTABLE . ALTERNATIVE TO ADOBE LIGHTROOM
Adobe Lightroom is a photo processor and image
organizer which allows view ng, mrganizing and
retouching large numbers of digital images. With
Lightroom, you can enhance and your photographs,
punch up colors, remove distracting objects and

o
oe

oo

y ¢O0¢ o0

"G
s

ce
o

it available for use.
https:ff%raphicsmob.cnm/wp—eontentf
upioads/2U21/03/pantone~-auto-pick~
color.jpgrezimgfmt=ng:webp/ngchbs

& 00 9e

Howeveyr, three Pantone Color books would remain:
Pantone + CMYK coated, Pantone + CMYXK uncoated, and
Pantone + Metallics Coated. The change means that
customers will need to buy Pantone Connect licences
to access all of the Pantone libraries via a plug-in. |
Adobe said the change had come about because |
“Pantone’s licensing with Adobe was adjusted”.

28 e wa

) It is a photography workflow application and raw
developer which manages digital negatives or RAW
images, lets you view them and have features to
enhance them. | .

It provides basic image operations like croE and
rotation, highlight reconstructions, white balance,
invert operation and exposure control. Tone image
operations include modification to the exposure,

- level adjustments, changing lightness, recreating
' contrast for HDR images et¢. darkable also includes
color image operations for correcting overexposure
and color, contrast, enhancing saturation and
manipulation of RGB channels. The Correction modules
helps you manage sharpening of details, noise level,
spot removal, chromatic aberrations and more.

DG
Qe
GO

WL, e ‘ pre-loaded color libraries .in Photoshop, Illustrator - straighten skewed shots color name. Type “y” to bring up

o g A Bl o A d i | IUS : | ¥ - . all the yellow colors in the book.,
-+ 3182 and InDesign would be phased out from gﬁAuqust 2022; When it comes to an alternative to Adobe Lightroom, The color will now sppear as your
§9 33 33 83 3% 33 &8 55 oo the move was flagged at the end of last year. | the best free and open~-source software is darktable. active color in the toolbar making
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 OTHER OPTIONS?
GIMP INTERFACE.
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ALTERNATIVE TO PHOTOSHOP
Adobe Photoshop is the most popular and widely used
graphics editing tool both for regular and
professional users. It’s an excellent tool for photo
editing, website design, and graphics creation. When
it comes to an alternative to Adobe Photoshop, GIMP
provides the best replacement., . '
GIMP is a free and open~source image editor
available for GNU/Linux, Mac, Windows and other
Operating System. It provides a handful of
sophisticated tools that make a graphic designer and
photographer’s work easier. From high-~quality photo
manipulation to original artwork creation, GIM
includes options to create icons, graphical design
elements, color management features etc. And the
customization options along with third-party plugins
make your work a bit easier.
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NATRON/BUTTLEQFX. ALTERNATIVE TO ADOBE AFTEREFFECTS
Adobe After Effects is a wvisual effects and motion
graphics application used for filmmaking and
television production. , _

Natron provides a perfect alternative to Adobe
After Effects with motion editing and multi-view
workflow. With an intuitive user interface and a
quick rendering, you can work with keyframes with a
very accurate curve editor. It can be used as a
command line tool and the command line version is
executable from ssh on a computer with any display.
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fi*Image of Scribus logo. This icon
hasn't changed since the releasa of
the cpaen~source program on the dth
jan 2007 19:44. k
https:l/gplond.wikimedia.org/
wikipedia/commons/9/9a/
Scribus_logo.png
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‘Scribus was used to create this

! | ‘ It supports smooth zooming and anning for large document, manual. This was my first
0 00 903 & sev e o o b INKSCAPE . ALTERNATIVE TO ADOBE ILLUSTRATOR images, and includes a full-featured dope-sheet to $LAN ASAY 8 Brooces TONERS B 4
SRR I S Adobe Illustrator is a standard tool suited for quickly edit clips and keyframes in time-space. thet Ehase was a 1of oF #trogale to

ButtlieOFX is another open source composition
software which grovides an intuitive Graph Editor to
connect nodes, Parameters Editor to customize effects
and three different Workspace layouts to switch in-

put my vision of the design on this
document. Even though the program
isn’t as golisheﬂ as InDesign there
are definitely interesting/ .
innovating ideas like the ‘Edit

vector graphics editing and design. With an
impressive set of draw ng tools and effects, it is
w%dely used for vector editing, posters creations
ete.
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MASTERPDE .

Inkscape is a very competitive, free and open

- source tool to Adobe Illustrator. A powerful vector

editor, Inkscape has flexible drawing tools, . ¥arious
file format compatibility, powerful text tools and

ALTERNATIVE TO ADOBE ACROBAT [NON-FOSS]
Adobe Acrobat is another application from Adobe

betwean according to

our needs.

The
bugs. I
from here,

Adobe InDasign
used primarily

project is still
you are willing to try, you can grab a copy

n alpha state s

for creating posters,

¢ there will be

% application
lyers,

brochures, magazines, newspapers, books etec. It

text with Story Editor’ option
where another window would EEE up
aud you saw only the text w no
style but the style attributes waere
iven on a side-menu. (There could

$e support for Bezler and spiro curves. It supports @ & possibility that this is also
| : advanced scalable vector graphics features like 3 ig Iitggﬁ éo?uhfjhawn’t found
s markets, clones and blending. SCRIBUS® . ALTERNATIVE TO ADOBE INDESIGN Obe thing that really bugyed me

is a desktop publishin when warking with this software is

that it is very apparent that the
created for

program wasn’t reall
g system. The

the Mscintosh operat

ity . Creative Suite which is ma n.lg used to view, create supports exporting & file to epub format for creation most apparent reason is the weird
and modify PDF files. The Adobe reader supgerts | of e~books. When 1t comes to an alternative to Adobe scmll‘gufferi;:q when your §rackpad
viewing, printing and annotating of PDF files while | InDesign, Scribus provides a powerful and easy fé:diﬁ1tr3§g$§ru§§§:ﬁn§qf;o‘ 2%&

02 JNCC 00CH OO0 Coo0 ¢ 0O
o

the Acrobat is used to create, -edit, convert, digital

alternative.

Scribus is a free and open source application

scroll down to another page to edit

° : Si%nr encrypt and export PDF files. i : some tewt. I think I will keep
¥ : t's difficult to find a fully functional open- available for all major operating systems and is tz:ying. © use¢ this program to set
: 28 source PDF editor. LibreOffice can be used edit a pdf myself iree from the monopoly board
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OPENSHOT . ALTERNATIVE T0 ADOBE PREMIERE

signing the PDF documents with ease. You can comment
documents with stamps, notes, text underlining and
£ill PDF forms easily.

Adobe Premiere Pro is video editing application from
Adobe System which is used for high-resolution video
editing, audio sample~level editing;, 5.1 surround
sound mixing and more. -
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I
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based on the free Qt tocolkit. From creatin? layouts
n

PIRACY . ALTERNATIVE TO THE WHOLE CREATIVE SUIT
Another option that I haven’t mentioned yet is

pirating the adobe creative suit. Pirating is the act

of stealing software that is legallf
includes copying, distributing, modif

place so that the
(programmers, grap

proper credit and compensation

F

eople who develo
ic artists, etc.

#

protected. This

ving, or selling
the software. Originally copyright laws were put into

software
would get the

for their work.

Lo Y as file with some limitation, and so can Inkscape. to typesettings and creating animated and interactive pue me eni: (bracacio ation system
x 3 However, Master PDF, the only proprietary software in PDF presentations and forms, Scribus is used to write interpretation®)
Y O R es TS0 4% et Bk this list supports all the features for editing a PDF newspapers, brochures, newslettars, posters, and
: N as file. It allows creating, editing, encryption and = books. - *This was my personal opinion,

experience using this Scribus but I
think if you are still learning
InDasign, graphic design as a whole
you should at least try to use this
progr&m for a few weeks.
{Definitely when using windows,
Linux) And even after you trial and
error you could always still crawl
back to the menopoly table.
(Anothex dramatic

interpretation)
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’I understand that there are othex
available options like screen
printing that is very cheap,
accessible to the lic but to
make my point as clear as possible
I am only referring to techniques
like risograph-, laser- and ink

printing.

PRINTING ‘

This open-source mentality has brought me to a new
technique for printing, by making use of the Axidraw
v3. This machine is extremely versatile and designed
to serve a wide variety of everyday and specialized
drawing and writing needs. You can use it for almost
any task that might normally be carried out with a

to plot your text or artwork.? It's all handled
through a straightforward graphical user interface,
and works cleanly on Mac, Windows and Linux.

QUICK SETUP

INSTALL THE SOFTWARE
Install Inkscape.

‘You can only ‘print’ in a SVG file
format this means that you need to
implement an already created SVG
file into Inkscape or convert you
work online using automatic
converting sites like ‘https://

cloudconvert . com/

f-to-svg’. These

or not always reliable so the best
option is to create, design your
work straight in Scribus or

Inkscape; when using Scribus you
need to export each page separate
as an SVG and outline your text.
Then open these pages in Inkscape
and place them in the right ordez.

- {(This order can differ depending on
h which binding method you use; for
example when binding & booklet with
g p:geg)the order is 8, 1, 2, 7, 6,

[ 4 #

All of the information needed for
‘printing’ with this new technique
is sveilable in this manual byt
here is the user guide for when

o, the reader need extra f
information or are j interested in
the inner working of the machine.
https://cdn.evilmadscientist.com/
di/ad/public/AxiDraw_Guide v550.pdf

Install the Axidraw plugin for Inkscape. {This plugin
will automatically be added to Inkscape after

handheld pen. It allows you to use Kour computer to
| restarting the software.)

produce writing that appears to be handmade,

complete with the unmistakable appearance of using a

real pen to address an envelope or sign one's name.

And it does so with precision approaching that of a

skilled artist, and just as importantly using an arm

that never gets tired. |
In my eyes you can call this act of 'perfect f

replication’ printing, the only difference is that

¥ou have more choice in the material that is used

or printing and the placement. -

SETUP THE AXIDRAW ,
l.Move the AxiDraw to its Home Corner.
¢.Plug in power and USB cables. (All USB plugs seem

to work: in the back of the computer (iMac).,..in
the keybcard, in a ushb hub..) - :
3.Add the pen to the plotter.
4.Position your paper with its upper-~left corner
below the pen tip. . ' | .
53.In Inkscape | | _
a.Select the drawing or text and select Path >
Object to path. -
b.Extensions > AxiDraw Control. Go to tab
setup. Click the Toggle pen between UP, DOWN
option. Click apply to toggle the pen down
and back up to check the correct
vertical movement. | |
i.Adjust the pen's height
ii.Try to keep the range of movement to
a minimum., This will draw faster and is
better for the servo motor.
c.Extensions > AxiDraw Control.
Tab Plot and click Apglf to start plotting.
~ (Each visible layer will print.) . |

*This also has environmentally
benefits because the mistakes could
he rectified there was no need to
throw away the paper and start all
over instead you could keep working
cn thet one paper. i

IMPACT ON MONOPOLY? | -
The interesting mechanism of the machine and effect
it gives to your grlnt is not the Oﬁlg reason I why
I want to bring this new printing technique ferwar§
 but also because I see a way to free yourself from
this large printing industry, monopoly. |
in the first part of this manual, I guided you
through the progress of escaping from the adobe k
creative sulte by giving you other options for their |
software. In the second part I wanted to also give
you other options but for the hardware that is in il
place instead of the software we use.
Narmallf when you need to print a publication,
poster.. with ‘good’ quality you need to already have
& high-end printer or go t® a printshop where they |
print it for you. Both of these tactics are part of
the capitalistic printing industry; owning a printer
is a very expensive and rigorous process; buying the
printer, repairing, ink, energy.. and when you ga to
a printshop the freedom of creating, printing it
yourself disappears.

‘When ueing graphite I also AL .
recommend using this mechani®dl

- pencil so that you only rfieed %o
click the top of the pen to make
;ﬂa point bigger instead of taking |
the pen out and sharpening it.

I have found two tactics thﬁf can
overcome this hardship; the ‘first
one ig te break yvour design-ug i
different parts and print these |
separate. For the second tactic you
need to go Lo your battery setting
and set the option “turn display
off after’ to for example 5 min,
What this does is make your
computer go to sleep after the time
set and thus alsu putting the
Axidraw to sleep. This technigue is
useful becsuse the ‘printer’ only
has a2 pause ~ and not a resume
button so when stopping the |
machine, you need to start all over
&?ain making the progress even more
difficule. ‘

USAGE b
When using this new technique one of the first
things you need to think about is the material vou

| are going to use. Different materials are going to

give different effects to your print. This manual is

| printed in graphite using a mechanical pen with a

width of 0.3mm.®, I chose this material due to the
open~source headspace I am trying to bring foreword;
the graphite makes it possible to erase aspects that
are not important, correct for the reader, create
space for their own natesg'to combine this manual
with their own work, etc.® Because of its erasable
character it made solving mistakes during the

printing progress a very easy progress. i

Different materials can also come with different
problems to overcome. The graphite pencil made the

P

3 few tips; whep using this .
technique of the most frustrating
things is that when the ‘printing’

rogress starts it is impossikle to

rk on Inkscape. Your computer
says, “Application Not Responding”
_tgt the software is just in use by
the ‘printer”. This technique is
more time consuming than any other
printing technigues, so the best

MORE ABOUT AXIDRAW ' e |
| ' AxiDraw V3 is the third-generation wersion of the
/ | AxiDraw, redesigned from the ground up for high
< - performance. It features smooth rolling wheels on
custom aluminum extrusions, specially designed for
high stiffness and light weight. Its sturdy, rigid
construction givas it finer quality output and in
most applications allows it to operate with |
significantly higher precision and speed than .
competing an BNy

eneration machines.

prewsons : i £F4 oty working method is to ‘print' in the
AxiDraw - : - | printing process itself very difficult due to the working P
Laboratoriés, _awggg r?;tinYc?f%ibg{ragtfgéagfggtmndsay point of the pencil becoming smaller and smaller the ?ggzkgiggggs:ngeggga;;&gg?m o il
Wilson of IJ Instruments Ltd. | further you get.’” The best tion when printing is to | The last tigdx want to give you is
ue

to create a dicated workspace';
what I mean whit this is a kind of
ogtlining with tape for example
where you put your paper in so vour
IMAGE PRINTING . ) designs placement is _always :
The last difficulty to overcome when using this pnT
- technique is the pxintlng of images. This is because )
the Axidraw only draws the outline of a shape, this
means that vou can’t just place an image in in
Inkscape because it will only draw the shape’of the
border and not the image itself. .
The following pages will show you different
options to make image printing possible and
interesting.® -

test different materials and see what effect they

AxiDraw machines are designed and manufactured by give or difficulties they create

Evil Mad Scientist in Sunnyvale, California, with
‘both foreign and domestic components. The major
structural components, including our aluminum
extrusions, are made in USA. | i

GETTING STARTED i |
The AxiDraw comes fullg assembled, tested, and ready
Lo use, right out of the box. A universal-input
plug=-in Bawer supply is included with the AxiDraw,
as 1s a USB cable, and an optional paper~holding |
easel. Assuming that you've installed the software
first, you can be up and plotting within minutes of
opening the box.Their comprehensive PDF user guide
walks you through every step of the process.? -

To operate Ax1Draw, you will need a reasonably
modern computer with an availsble USB port {(Mac,
Windows or Linux), plus internet access to download
necessary software. Pens and paper are not included.
(You can use your own! AxiDraw does not require
proprietary pens or pap '

g

er.) ”

AxiDraw 1s normally controlled through a set of
extensions to Inkscape, the excellent, popular and
free vector graphics program. Basic operation is
much like that of a printer driver: you . import or
make a drawing in Inkscape, and use the extensions

3
i
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